2016-17 KSIS
Beginning-of-Year Training

State Board Room (125), 500 Mero Street, Frankfort and KDE Media Portal
April 20 and 21, 2016
9:30 a.m. (ET) / 8:30 a.m. (CT)

nks to join the training

For the KDE media portal, right click and open the
hyperlink or copy and paste it into your browser:
http://mediaportal.education.ky.gov/watch-live

» To ask questions, right click and open the hyperlink or
copy and paste it into your browser:

http://app.gosoapbox.com Access Code: KDEData

» Have a technical issue? Contact your district
technician.
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Becky Jenkins
Office of Education Technology
Division of School Data Services

J&A and EILA Credit

Presentation slides and agenda
KDE KSIS Training Web page
» Have a question? Post it to GoSoapBox:

http://app.gosoapbox.com Access Code:
KDEData

» Want EILA credit?

Register and complete the post-training
online evaluation/self-attestation survey.

‘Welcome & Houseleeping Becky Jenklns, Office of Education Technology (OET), Division of School Data Services.
502:564-2020 x 2475
MSGP, OET, Division of School
and Teacher Tumover 502:564-2020 x 2479

‘Christine Melsenberger, Office of Teaching and Learning (OTL), Division of Next Generation Professionals.
502.564-1479 x 4510

—— —
Bt
10:35 Break
rogr: . , Office of Career & Technical Education (OCTE), Division of Technical Schools and Federal
e
TS Data Exchange - Attendance Sync Setup & ‘Tanya Fluke, Office of Career & Technical Education (OCTE), Division of Technical Schools and Federal Programs.
Preparation 502-564-3472 x 4205
.
e

502:564-3472 x 4205

o
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Teacher Course Assignments, |
MSGP, Student Voice and Teacher
Turnover

Begins at 9:35 a.m. (ET)

Ask questions and interact with presenters through

GoSoapBox: http://app.gosoapbox.com
Access Code: KDEData

Teacher Course Assignments,
MSGP, Student Voice and
Teacher Turnover

Shale Detwiler, Resource Management Analyst
Office of Education Technology
Division of School Data Services

Teacher Course Assignments - The
Connections

» Teacher Student Data Links

e Course sections connect teachers to
students

v'Teachers are assigned to a course section
v'Students are rostered to a course section

o See Teacher Student Data Links web page
for training videos

Shale Detwiler
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Teacher Course Assignments —
Beyond LEAD Reporting

» Important for
o Calculating Median Student Growth Percentile
v'4th-8th grade Math and Reading teachers

V'3 years of student associations
e Sending Student Voice Survey Invitations
v'Current year rostered students receive invitations
o Calculating Teacher Turnover Percentile

v'Used to determine if a teacher returns to the classroo

Shale Detwiler

Teacher Course Assignments and
Median Student Growth Percentile

P Calculated using 4t through 8t grade
reading and mathematics Student
Growth Percentile (SGP) scores

» 3 year period of teacher and student
connections

» Courses used for MSGP calculation can
be found on the Median Student Growth .
Percentile web page

Shale Detwiler

Teacher Course Assignments and
Student Voice

» Method for students to provide feedback
about their current school year teachers

» Teacher assignments and student rosters
are used to determine

o Which survey type will be sent to a teacher’s
students

o Which students will receive an invitation for a
teacher’s survey

Shale Detwiler
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Teacher Course Assignments and
Teacher Turnover

» Reports the percentage of teachers who
have left the classroom in a school

» Determined by
e Teacher course assignments

v'Teacher may not have left the school - just the
classroom

o District employment and assignment end date

Shale Detwiler

s Depart,
=) e,

Best Practices

» Reflect reality in the classroom

o All teachers in the classroom should be
assigned to the course section

v'Lead teachers

v'Co-teachers =" e e | D
. THACHER. oM
vAssistant Lo C
pos
teachers TR fouR

v’ Other
Professionals

Shale Detwiler

Best Practices

» Use Assignment Start and End
Dates on Staff History Detail
tab of Course/Section > Staff
History il

TEACHER ONE 7]
Asvgnmant

o Mid year teacher changes —— o

Access 1o Section Dates.

o Long term subs

© Unwsrcind
e e

Commerss

Shale Detwiler
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Best Practices

» Ensure courses are scheduled during
instructional time
o Instructional time affects
v'LEAD
v'Student Voice
v'Teacher Turnover

o Practice of scheduling courses during non-
instructional time does not work for Kentuck

Shale Detwiler

Best Practices

» End date appropriately

o Employment at the school ends, use District \
Assignment: Employment Assignment Information
editor

o« Employment at the district ends, use District
Employment: Employment Information editor

o End dating ends IMS access
» Review student rosters
o Have process for regular review to ensure accur

Shale Detwiler

Helpful Reports

» Path > Scheduling > Reports >

o Staff History Report
v'Provides list of courses with assigned teachers

v'Includes Primary and Secondary teachers, and Section
Staff

e Section Roster Report
v'Provides list of students rostered to course sections

» See Campus Community for more information =
about these reports

Shale Detwiler
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More Helpful Reports

» Reports are specific to calculations or programs"g
« MSGP

v'Teacher Course Check, MSGP - Detail, MSGP -
Summary

o Student Voice

v'Projected Counts, Educator with List of Students,
Progress Monitoring, Teacher Results

e Teacher Turnover
v'Teacher Turnover Details

Shale Detwiler

Helpful Median Student Growth
Percentile Reports

» PATH: KY State Reporting > KDE Reports > k
o Teacher Course Check

v'Use to verify courses are aligned to appropriate
state codes

e Median Student Growth Percentile — Detail

v'Shows detail used to calculate teacher MSGP
scores

e Median Student Growth Percentile - Summary
v'Shows MSGP scores for teachers by school

Shale Detwiler

to state codes

e Shows

v'Primary teacher

v'Corresponding state code

v'Indicator for MSGP calculation connection

Shale Detwiler




Use to Verify Course Alignments

» MSGP_Calc shows the MSGP connection

o NA indicates the course is not used for MSGP
calculations

o Reading and Mathematics indicate the course is
used for MSGP calculations _

K L

\

MsGP_Cale |
Reading
Reading
Mathematics.

1900 $th Grade Language Atts 702020 Intermediate Language At
3800 8th Grade Math 270203 Eighth Gr Moth

5800 Geography 450189 Soe. Studies Gr 6 World
5801 US History 450191 Soc Studies Gr 8 Am (US
9009 Study Skills 904010 Study Skills

3800 Pre-algebea 270206 Accelerated Eighth Gr Math

Shale Detwiler

Median Student Growth Percentile — |
Detail and Summary

» New this falll! 2 year median combined
score

o Median of the SGP scores for two most current
years within calculation period

o Teacher must have a single year median for
both years

Shale Detwiler

Median Student Growth Percentile — 1
Detail

» Output is Excel file
» Provides details for
e Student and course connections
e SGP scores for connected students
o If student was with the teacher in a classroom for
100 instructional days
» Displays single, 2-year, and 3-year medians in
final columns . .

KTeacher
s
ns

EEEEX

ns
ns

Shale Detwiler
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Student Voice Reports

» Path: KY State Reporting > KDE Reports >
« Student Voice - Educators with List of Students °
o Student Voice - Progress Monitoring

o Student Voice - Projected Counts

o Student Voice - Teacher Results

Shale Detwiler

Student Voice Reports

» Student Voice - Educators with List of
Students
o For each teacher, shows which students were
sent a survey and if the student has completed
the survey
» Student Voice - Progress Monitoring

e Shows how many surveys were sent and how
many completed surveys are usable to
calculate a score

Shale Detwiler

Student Voice — Projected Counts

» For each teacher, shows an estimated
number of students who will receive a
survey invitation

» Use Student Rosters to verify estimated
count of students

» All teachers should show on the report, even
if marked as “Not Participating”

o

Shale Detwiler
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Student Voice — Projected Counts

» “No Valid Selections” indicates teacher’s | e
assigned courses will not generate surveys \

o Courses not during instructional time
o No students in grades 3-12 rostered to course

Student Voice - Projected Teachers and Student Counts.

SCHOOL ONE Start: 10/03/2016 7:00 AM End: 10/07/2016 5:00 PM
Last Name First Name. D GraLvi Student Count
TEACHER FIVE 54321 None No valid sections.
TEACHER FOUR 12345 Gr.3s %
TEACHER one oz Gre12 15
TEACHER THREE 09876 None. Not Participating
TEACHER ™o 99663 Gr3s Ne vaiid sections
Shale Detwiler -

Student Voice — Teacher Results

» For each teacher, shows the question and B oucatiss
construct response scores |

» Available immediately after a survey ends

» Infinite Campus responses are archived at end
of each school year

o If report is desired for future reference, run report
and maintain a secure copy per district guidance

o Results will still be available in CIITS/EDS

Shale Detwiler

Student Voice — Teacher Results
Output

Student Voice - Teacher Results - Grade 3.5

School: SCHOOL ONE Disuict:  Kentucky County Survey Dates: 1003161007116

Teacher: TEACHER ONE Totsl Number of Respondents: 13
es, Mosty  Maybel  Mosty  Ho,
Always  Yes  Sometmes Mot Never
Support - 54% Posave
My beacher pushes us 1o Tk hard abcut TGS we 163 e 21 154% L)
My heacher pushes evenybody 1o work hard s 1% 154 7
1104 355 e P30 10 Tk P 35081 W) we 5. e w 1% 1w 2
Transparency - 4% Posiive
110 s we o 5 correc ot mstakes nm xe 0% s 77
Ths cass 5 neat-everying fas 2 place and Sings e sasy 1o fnd 2% 0w 0% % e
My teaches erpiams tavgs  very oe0eny ways nm 0w n% aw 7
" a0 2% s 2
Shale Detwiler a

7/20/2016
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Teacher Turnover

» Is part of the Equity measurements on School
Report Card

» Shows the percentage of teachers who have left
the classroom in a school

o Teachers promoted to non-classroom positions
(i.e. promoted to principal)

o Teachers who left a school to teach at a different
school

o Teachers who left teaching

Shale Detwiler

Teacher Turnover

» A teacher is considered to be:

e Educator assigned to at least one course
section during instructional time

e Has an EPSB ID entered in Campus Credentials
page
» Teacher Turnover Detail

e Report that provides the detail used to
determine the turnover calculation

Shale Detwiler

Teacher Turnover Detail Report

» Path > KY State Reporting > KDE Reports >
Teacher Turnover Details
» Options:
e Choose a school or all schools from Campus Tool
Bar
o Beginning this fall
v'Two years of calculations will be available
v'Will be able to choose year from Campus Tool Bar
*only available for 2014-15 and 2015-16 school years

Shale Detwiler

7/20/2016
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Teacher Turnover Detail Output

» Turnover column shows if a teacher is counted as
turnover
» Final three columns show \

 Number of teachers considered turnover (column:
School Turnover Sch)

o Number of teachers at end of year 1 (column: School
Teacher Total Sch)

o Turnover percent (column: School Turnover Calc Sch)
» Turnover calculation

o # of teachers considered turnover divided by # of
teachers at the end of year 1

Shale Detwiler

Helpful Websites

» Teacher Student Data Links

KDE Home > Teachers/Leaders > Professional Growth and
Effectiveness System > Teacher Professional Growth and
Effectiveness Systems (TPGES) > Teacher Student Data Links

http://education.ky.gov/teachers/PGES/TPGES/Pages/Student-
Teacher-Data-Links-for-Student-Growth-Percentiles.aspx

» Teacher of Record Data Standard

KDE Home > District/School Support > Technology > Kentucky
Student Information System (KSIS) > KSIS Data Standards

http://education.ky.gov/districts/tech/sis/Documents/Data_Stan .
dard-Teacher_of_Record.pdf

Shale Detwiler L

Helpful Contacts

» MSGP
Christine Meisberger
Christine.Meisberger@education.ky.gov
(502) 564-1479 ext. 4510

» Student Voice
Joyce Richards
Joyce.Richards@education.ky.gov
(502) 564-1479 ext. 4532

» Equity
Jennifer Baker
Jennifer.Baker@education.ky.gov
(502) 564-1479 ext. 4501

Shale Detwiler Z

7/20/2016
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Additional Contact Information

» Shale Detwiler
Office of Education Technology
(502) 564-2020 ext. 2279
Shale.Detwiler@education.ky.gov

Shale Detwiler

FERPA, Phishing, and Security
Fundamentals

Begins at 10:05 a.m. (ET)

Ask questions and interact with presenters through

GoSoapBox: http://app.gosoapbox.com
Access Code: KDEData

FERPA, Phishing, and
Security Fundamentals

Robert Hackworth, Security Program Manager, CISO
Office of Education Technology
Division of Engineering & Management

7/20/2016
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“We Got a LONG Way to Go...”

Robert Hackworth

Can we be 100% Secure?

» Nope. No such thing, but we have to try

» Like outrunning a bear, we just have to be
faster (or more secure) than the other guy...

» | like our chances. |

Is all Security “Good Security?”

]

7/20/2016
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Is All Security Convenient?

» Nope. Not in the short term

» But, YES in the LONG TERM

The Most Secure Car in the WORLD

So, Good Security...

» Keeps our important stuff SAFE until we
need it. [

15



The Basics — Your Keys to Security

» Passwords

o Tough to guess (avoid names, months, seasons, “password,” other
stuff found on Facebook)

o Unique (especially for work, finance, shopping sites)
e Longer is better
e Change it often (limits the damage if it's cracked or guessed)

o Don’t share it (you may trust your friend, but do you trust THEIR
friend?)

» Examples:
* 5$toOLb3IT (five dollar tool belt)

e MeOaDeOalLel! (Mares eat Oats and Does eat Oats and little Lamb:
eat Ivy!)

o AGreat'Vette! (ok, not AWESOME, but better than “password@z/oi

The Basics — Your Keys to Security

» Mobile Devices (phones, laptops, tablets)
« Keep them out of site!
¥ In the trunk, NOT the footwell
v Put them in the trunk BEFORE you get to your parking space at the Mall...
« Keep them password or PIN protected
v Prevents a thief from getting into your email, Banks, Amazon, Facebook, etc.
« Keep your OS and apps updated
v Updates add functionality AND ALSO fix security holes (there are ALWAYS holes)
« Be careful of free wifi

v Make sure you are connecting to legitimate network, not just the first free one
you see

v Crooks can and do set up fake SSIDs to intercept your network traffic

The Basics — Your Keys to Security

» Phishing

o Look out for unusual emailed requests from district staff. Phishers
are getting good at impersonating our Superintendents and other
staff over email

o Is an email asking for your password? Your SSN? Is it TELLING you to
do something RIGHT NOW? Or ELSE?

o Did you get an email with an attachment you weren’t expecting? A
resume?

o If it sounds too good to be true, it probably is (Nigerian Prince, Bill
Gates giving away $50, etc.)

e Forward all suspected phishing emails you get to your CIO or
helpdesk 4

o If you believe you have fallen for a phish, change your password and
contact your CIO or helpdesk immediately v

7/20/2016
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The Basics — Your Keys to Security

» Email
o The easiest way to accidentally share too much
information

v'Screen shots in KSIS that show bunches of students’
information, not just one

v'Top Secret information lurking in attachments like
spreadsheets or presentations

v'Wrong addressee (Bobby Hackworth, PES vs. Robert
Hackworth, KDE)

o KDE does NOT want or need SSNs 99.9% of the time
vJust the student ID (SSID) and the name will suffice

The Basics — Your Keys to Security

» External Storage (Hard drives, thumb drives and
the such)

« Do not store Top Secret information on these devices if
at all possible

v'UNLESS encrypted with a password

o NEVER pick up and use thumb drives you find on the
sidewalk or parking lots

o Keep them out of site, just like your laptops and cell
phones

» And SPEAKING of Top Secret Information...

Disposing of Top Secret Data

» When you throw it “away,” what does “away” mean?
» Top Secret Data find their way onto lots of different media:
e Computers
« Phones
e USB Thumb drives
e Printer/Scanner/Copiers
o Floppy Disks
« CD-ROMS

If you have any of the above, and they are no longer needed, or
the data on them are no longer needed, the best thing to do is
to destroy, delete, clean, wipe, etc. Contact your CIO or
Helpdesk.

v

Y

7/20/2016
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What is Top Secret Information?

» Kentucky’s House Bill 5, or KRS 61.931, et seq.
o Clearly defined
o Will trigger a data breach if exposed
« Not limited to students - info that we all have
» Kentucky’s House Bill 232, or KRS 365.734
o Not clearly defined (very broad)
e Focused on cloud service providers’ use of student data
» FERPA (Family Educational Rights and Privacy Act)
o Pretty clearly defined, but depends on context
o Sensitivity can vary depending on use, viewer, other factors
o Can trigger a data breach, depending on district sensitivity

Kentucky’s House Bill 5, or KRS
61.931, et seq.

States "Personal i means an indivi 's first name or first initial and
last name; personal mark; or unique biometric or genetic print or image, in A
combination with one (1) or more of the following data elements:

» An account number, credit card number, or debit card number that, in ";
combination with any required security code, access code, or password, would 1
permit access to an account;

A Social Security number;
A taxpayer identification number that incorporates a Social Security number;

v

v v

A driver's license number, state identification card, or other individual
identification number issued by any agency;

A passport number or other identification number issued by the United States
government; or

Individually identifiable health information as defined in 45 C.F.R. sec. 160.103
except for education records covered by the Family Educational Rights and .
Privacy Act, as amended 20 U.S.C. sec. 1232g.

v

v

Kentucky’s House Bill 232, or KRS
KRS 365.734

Defines "Student data" as any information or material, in any
medium or format, that concerns a student and is created or \
provided by the student in the course of the student's use of cloud
computing services, or by an agent or employee of the A
educational institution in connection with the cloud computing
services. Student data includes:

» the student's name,
» email address,

» email messages,

» postal address,

» phone number, and

» any documents, photos, or unique identifiers relating to the -
student -

7/20/2016
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« Departg,

Family Educational and Rights
Privacy Act (FERPA)

Defines the rights that parents and students have to their own data and protects
i ion in ion records that are maintained by an educational
agency or institution or by a party acting for the agency or institution. Those data
include, but are not limited to:

» student's name,

» the name of the student's parent or other family members,

» the address of the student or student's family,

» a personal identifier, such as the student's social security number, student

number, or biometric record,

other indirect identifiers, such as the student's date of birth, place of birth, and

mother's maiden name, and :

» other information that, alone or in combination, is linked or linkable to a
specific student that would allow a reasonable person in the school communit;
who does not have personal knowledge of the relevant circumstances, to
identify the student with reasonable certainty

v

FERPA continued

» Annual FERPA Notification?
o Has it been reviewed this year and made publicly available?

¢ Do you know who student data can be shared with under the
School Official Exception?

o Directory Information Exception?

v'What is Directory information? It's personally identifiable
information that is contained in an educational record of a
student that would not generally be considered harmful or an
invasion of privacy if disclosed. It can be disclosed without
permission from the student or parent.
» Usually: Name, field of study, attendance, grade level, extra-curricular
participation, height/weight if in athletics, honors, schools attended,
and data of graduation. F
» Do you know what YOUR SCHOOL has determined is Directory Information?

The End

» Robert.Hackworth@education.ky.gov

7/20/2016
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Kentucky Dual Credit
Scholarship Program

Begins at 10:50 a.m. (ET)

Ask questions and interact with presenters through

GoSoapBox: http://app.gosoapbox.com
Access Code: KDEData

Dual Credit Scholarship
(DCS) Data Requirements

Kiley i ic Program

Office of Career and Technical Education

Dual Credit Scholarship Program
» Established by Executive Order 2016-378

» Administered by Kentucky Higher Education
Assistance Authority (KHEAA)

» Post-secondary institutions must opt into program ‘
o List of participating post-secondary institutions (PPI) will
be published
» Establishes a Dual Credit tuition rate ceiling for all
dual credit coursework at PPI
» Scholarship can cover the cost of two courses in
SY 16-17 per high school student

Kiley Whitaker

7/20/2016
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Dual Credit Scholarship Program

» Districts must send KHEAA detailed information
about all dual credit courses taken by students

o KHEAA will notify PPI of scholarship eligible courses

o Students will not be billed for scholarship courses
but will be responsible for additional courses

o Districts will receive funds from KHEAA
o Districts will pay the PPI

» All required data is not currently available in
Infinite Campus

Kiley Whitaker

Dual Credit Scholarship Questionsi‘a,n |

» Becky Gilpatrick at KHEAA

o rgilpatrick@kheaa.com
* (800) 928-8926 x 67394

» DCS Executive Order 2016-378
» DSC Guidance Document
» DCS Q&A

Kiley Whitaker

Existing Dual Credit Requirements\

» State Code

» GPA Weight (Critical for KEES)
» Type

» Difficulty Level (KEES and DCS)
» Teaching Method

» Instructional Setting

» Attendance
Kiley Whitaker

7/20/2016
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New DCS Requirements

» Post-Secondary Code (College Code)
» Course Name
o Post-Secondary Course Abbreviation
o Post-Secondary Course Number
» Lab Indicator
» Scholarship Indicator

Kiley Whitaker

. Depare,
sy DeParton,

Dual Credit Scholarship Report
» Under development for August release

o Will be under KY State Reporting > KDE Reports
» Will be for grades 9-12
» Will be a CSV file format

» Districts will need to manually add data on the
CSV file at least this first time

» File will be uploaded by the district to KHEAA
using the same mechanism as KEES

» Will contain additional local course informati

Kiley Whitaker 2

KHEAA DCS File Format (CSV)

Field Name
Student SSN
LastName
FirstName

Middlelnititial 1
DateofBirth 4 mmaddceyy
DistrictCode 3
SchooiCode 3
GradelLevel 2
AcademicYear 8 ceyyceyy
Semester i
CollegeCode 8
CourseAbbrevation 4
CourseNumber 4
CourseSection 4
Lablindicator 1
ScholarshipCourse 1
Kiley Whitaker

7/20/2016
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) Ty,

Dual Credit Scholarship Timeline

» Fall Semester Data Due to KHEAA
o August 30th

» Spring Semester Data Due to KHEAA
e January 30t

» Fall 2017 Data Due to KHEAA
o June 30t

Kiley Whitaker

Future DCS Data Collection

» Eliminate need for manual entry outside
of Infinite Campus

» Report would generate in format to load
to KHEAA

Kiley Whitaker

Future DCS Data Collection Preparation |
» Each dual credit course should be set up as a ‘

separate course in Infinite Campus
» Use the course name to define

o Post-Secondary Course Abbreviation

o Post-Secondary Course Number

o Format: AAAA NNNN

v'One space between abbreviation and number

v'No dashes or underscores in first nine characters
e Examples
v'OST 105 for Office Systems Technology 105

v'ENG 101 for Writing |
Kiley Whitaker

7/20/2016
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DCS Data Collection Proposal
» Possible new data elements

230404 ENG 101
Coun cioes  Gendng T

DCS College Code

00524400 Bluegrass Comm & Tech College v

DCS Lab Ingicator

O

DCS Data Collection Idea

» Scholarship Indicator
o Student level per course
o Possible idea
v'Use a grade book assighment

v'Please email feedback on using an assignment or
other ideas for collecting the scholarship indicator
inside of Infinite Campus to
lisa.keeter@education.ky.gov

Kiley Whitaker

Resources

» Dual Credit Ad-Hoc Report
o State Published
vcurriculum Dual Credit Courses

» Dual Credit Course Data Standard
» Dual Credit Course Indicators Guidance

» Dual Credit Web Page

Kiley Whitaker

7/20/2016
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Questions

To ask questions, click: https://app.gosoapbox.com/
Access Code: KDEData

Kiley Whitaker

Features You Might Want to
Investigate on Campus Community

Kiley Whitaker

Features for Courses

» Course Masters have all Course Fields
o This includes custom fields

e Only locked fields push to existing courses
» External LMS Exclude Indicator
o Added on several screens including course

 KDE is not currently utilizing this field for CIITS
data pulls /

Kiley Whitaker

7/20/2016
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Features for Grading

» District Management of Grading Set Up

o See Course Masters; Courses; Course Catalog
» Guest Access to Gradebook
» Post Only Grading Tasks and Standards

o See Grading Tasks (Courses); Grading Tasks (Course
Masters); Standards; Standards (Course Masters)

» Grading Set Up Audit Report
» In Progress Grades Available in Ad Hoc Reporting

o Student > Grading > Grading Detail >
progressPercent and progressScore

Kiley Whitaker

Features for Teachers

» Discussions
» Copying Assignments in the Gradebook
» Instructional Planning

» See Search the Library for Assignments, Creating |
Assignments, Other Curriculum, Curriculum
Report, Curriculum Templates

» Multi-Post Grades

Kiley Whitaker

KTS Data Exchange -
Attendance Sync Setup &
Preparation

Begins at 1:00 p.m. (ET)

Ask questions and interact with presenters through

GoSoapBox: http://app.gosoapbox.com
Access Code: KDEData

7/20/2016
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KTS Data Exchange
' Attendance Sync Setup &
Preparation

Tanya Fluke, Systems Consultant IT
Office of Career and Technical Education
Division of Technical Schools and Federal Programs

KTS Attendance Essentials

v Technical school teachers must post period attendance

v Technical school clerks must maintain check in/check out
records

v Technical school clerks must check the Classroom Monitor to
verify teachers have posted attendance

v Technical school clerks should reconcile daily attendance*

¥ High school attendance clerks must review technical school
attendance data & enter correct attendance into their district IC
database

v Technical school clerks & high school attendance clerks shoul
keep a continuous open line of communication

I thefeedir igh school participates n the unknown attendance sync,th tectnical school must wait unti the next school day to

reconcile previous school day attendan

Tanya Fluke

»» Attendance Responsibilities

| = :
S Technical School
(3

-—

Tanya Fluke

7/20/2016
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Technical School Clerk Responsibilities

» Technical school clerks must
« Update their IC database with any attendance corrections
«Maintain check in/check out records, and share those with the high school attendance clerk
« Check the Classroom Monitor continuously throughout the day to ensure teachers have posted attendance
« Runand review the KTS Attendance report daily

Communicate and work with their high school attendance clerks to ensure the entry of accurate attendance
data in the high school IC databases

»  Technical school clerks should
«  Reconcile attendance* in the technical school IC database to:
< Maintain data integity
+ Ensure KTS Attendance report accuracy
 Rssistteachers with makeup work decisions

« Refer to the Attendance for Technical School Clerks documentation, which outlines the various ways
to maintain and reconcile attendance in Infinite Campus

* If the feeder high school participates in the unknown attendance sync, the technical school must wait until the next school dayt
reconcile previous school day attendance.

Tanya Fluke

»» Attendance Responsibilities

= \

S '

S High School |
-Q

Tanya Fluke L/

High School Attendance Clerk
Responsibilities
» High school attendance clerks must

. with the school clerk to ensure the entry of
accurate attendance data in the high school IC databases

« Supply the technical school clerk with lists of students who are held at the
high school due to special functions or events (i.e. testing, counseling, or
assemblies) or attendance events not yet entered into Infinite Campus (i.e.
suspensions, field trips, or home hospital)

« Run and review the KTS Attendance report (KY State Reporting > Edit
Reports > KTS Attendance), and use this report as a guide for manual
attendance entry in the high school IC database

Tanya Fluke Z

7/20/2016
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High School Attendance Clerk

Responsibilities

» Compare the KTS Attendance report (KY State Reporting’,
> Edit Reports > KTS Attendance) to the Daily
Attendance (Attendance > Daily Attendance) You may |
want to make an ad hoc filter to pull only KTS students
to make comparison easier

A guide to creating
this ad-hoc can be
found here

Tanya Fluke

High School Attendance Clerk

Responsibilities

» If a student is not on the daily attendance
report but is on the KTS attendance report:

o Work with technical school clerk to determine
if the student is actually there

V'If the student is there, attendance should be
corrected at the technical school

V'If the student Is not there, enter an unexcused
check out at the high school until the student’s
whereabouts can be determined

Tanya Fluke

5 &I Helpful
- & > Ad-hoc Query

Q * Student Feeder

- School Ad-hoc Query

(For Technical Schools)

* Technical Student Ad-
hoc Query (For High Schools)

Tanya Fluke
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Student Feeder School Ad-Hoc Query !

For Technical Schools
» Go to the KTS Data Exchange webpage.
» Locate & open the Student Feeder School Ad-Hoc

Query, under the User Resources heading on the
right side of the screen

» Open the document and follow the directions to
create the ad-hoc query in your personal Infinite
Campus user account for future use

» Suggested uses:
¢ Rosters
o Attendance Wizard
« Reports

Tanya Fluke

Technical Student Ad-Hoc Query
For High Schools

» Go to the KTS Data Exchange webpage

» Locate & open the Technical Student Ad Hoc Querv.“
under the User Resources heading on the right side
of the screen \

» Open the document and follow the directions to
create the ad-hoc query in your personal Infinite
Campus user account for future use

» Suggested uses:
« Rosters
o Attendance Wizard
« Reports

Tanya Fluke

Reports |

»» Real-time Reports Specifically
for KTS Attendance

=1

=

- &7
Qg

Tanya Fluke
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KTS Attendance Report

K State R

 Eat Reports

KTS Atiendance

e
Cierem———

Pathway: KY State Reporting > Edit Reports >
KTS Attendance

The KTS Attendance report will:

Allow users at the technlcal school (ATCs &
CTCs) to view student’s attendance in their
ict, where all feeder schools are on

the same rep

Allow users at the high School to view student's
attendance for all technical students, includes
students from all servicing high schools within
the district.

Tanya Fluke

Reporting

t Reports

KTS Aendance

KTS Atiendance By School

Pathway: KY State Reporting > Edit Reports >
KTS Attendance by School

The KTS Attendance report will:

Allow users at the tachnical school (ATCs &
CTCs) to view student’s attendance in their
home district, which is filtered by school. if
the district has more than one participating
school.

Allow users at the high school to view
student's attendance for technical students,
filtered by high school, and omits students
attending from other high schools within the
district.

Tanya Fluke

»%» Optional Feature
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KTS Unknown Attendance Sync

» Unknown attendance from the technical school will sync‘\,

to the high school during the overnight sync \

« Previous days’ teacher attendance from the technical school
will show yellow (unknown) on the Daily Attendance Report,
Student Attendance tab, & Parent Portal after the overnight
sync

v'Will not overwrite attendance that is currently at high school

v'The Classroom Monitor will not reflect that technical schools have
taken previous day attendance (i.e. turn course from pink to
green)

Tanya Fluke -

KTS Unknown Attendance Sync

v

Will be available SY 2016-17
This is an optional feature that is controlled at the district
level by the district Infinite Campus administrator.

System Administration > Resources > School > Select High
School > Synchronize Tech Center Attendance checkbox
Tech Center

v

v

]

Checking the box will turn the feature on. Unchecking turns
the feature off

The check box must be checked for each high school in the
district that wishes to participate

v

v

Tanya Fluke L

Questions?

Tanya Fluke
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Support

» Technical School Attendance Questions:

o Tanya Fluke, Office of Career & Technical
Education ktssupport@education.ky.gov &
Tanya.Fluke@education.ky.gov

» High School Attendance Questions:

e Garnetta Barnette, Office of Administration &
Support Garnetta.Barnette@education.ky.gov

Tanya Fluke

KTS Data Exchange - Proper}"i
Course Setup

Begins at 1:50 p.m. (ET)

Ask questions and interact with presenters through

GoSoapBox: http://app.gosoapbox.com
Access Code: KDEData

KTS Data Exchange:
Proper Course Setup

Tanya Fluke, Systems Consultant IT
Office of Career and Technical Education
Division of Technical Schools and Federal Programs

7/20/2016
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KTS Proper Course Setup N L

» Proper course setup is essential for syncing success
o Refer to the KTS Course Setup Guide

« Be sure that you are retrieving courses from the correct
catalog

o Pay attention and use care to pull in the correct course code
for your school

v'Refer to KTS School ID Numbers to locate the Tech ID for your
technical school

o High schools should only attach ONE section per course

o Refer to the KTS Grading Task Setup document to complete
proper setup

Tanya Fluke .

Course Numbering and Scheduling

Explanation of Course Codes for KTS - Campus Data Exchange

Which the course is taught is section three, and indicated by (0

Course Catalogs

. 1518 KTE Course Caiog (90H SCHOOLS ONLY
High School & C16-17 KTS Courna Calog (40H SCHOOLS ONLY)
Course Setup o1 ) et
& ) Bty Dt ot
Document j..ﬁ:& u:::‘“‘
& 2 Specillieeds
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Grading Setup and Syncing

e o s

Grading Tasks

Grading Task

1) Ot emide . Setup
1 veTemarace Document
13 e Weeks Grades
0 creFratam
1) suteets Grates
1 creFracase T —

T —
e o=
PR e PamegCiet % =
b =
* s e 1 ms v
X3 - s
) - s
X - s
X5 m - s
Xe s s
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Important Grading Task Details

v

Only use CTE Term Grade, CTE Final Grade and CTE Final Exam
grading tasks

o The use of any other grading tasks will result in an unsuccessful sync

v

For CTE Term Grade, CTE Final Grade and CTE Final Exam grading
tasks - use each of those grading tasks only ONCE
« If you notice more than one of these grading tasks attached to a course, do
not delete, notify ktssupport@education.ky.gov

v

Only one Active Mask should be checked at a time
e More than one checked will produce an error and an unsuccessful sync

v

Check that the proper Score Group is attached to each Grading Task -

« You may use the CTE Numeric Score Group or a score group within your
district that matches the CTE Numeric Score Group on the Minimum %
column ’

Tanya Fluke i

Grading Window Tool

» Use the Grading Window tool to change the
Active Mask in mass to the current term

o Grading & Standards > Grading Window
» Technical schools & high schools should
communicate and coordinate with each other
when term Active Masks need to be changed
» Active Masks can also be updated individually
by going directly to the individual Course >
Grading Task

Tanya Fluke v

Grade Calc Options Setup
Technical Schools Only

» Technical schools must edit the Grade Calc \
Options tab for each course before school starts \\
o Refer to the KTS Grade Calc Options Setup guide

» High schools DO NOT need to use the Grade
Calc Options tab for KTS Data Exchange courses

o The CTE Final Grade received at the high school
will be a composite grade which syncs from the
technical school

Tanya Fluke /
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Process Alert Messages

» Check the Process Alert area of your IC homepage for
any possible course or active mask setup issues
If you are a high school and do not see KTS messages populating in your Process Alert area,

forward the Data Exchange User Group document to your district IC System Admin and ask
them to follow the directions for proper setup

Process alert messages explain issues down to the specific course number and section

Tanya Fluke

Troubleshooting Setup or Grade Sync
Issues ‘

If setup or grade sync issues arise, refer to Troubleshooting Tips ',
PowerPoint and/or Video for guidance \
Look for KTS Project Errors, in the Process Alert area for
messages regarding possible issues
Communicate with your KTS Team (scnica school principa andjor clerk, nigh school
scheauler, and distict 1Csystem aamin) F@GArding issues to facilitate a setup review
in both databases
If the above suggestions do not resolve the issue, email
ktssupport@education.ky.gov with details, examples and screen
shots of the issue.

o For FERPA compliance, do not email any student identifiable

information, except SSID numbers.
« Redact student identifiable details on screen shots before sendingN

v

v

A4

A4
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Additional Support

» KTS Data Exchange webpage
» Campus Community

» ktssupport@education.ky.gov

Tanya Fluke
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Wrap-up

Thank you!

You can ask questions through GoSoapBox
tp: .gosoapbox.com
Access Code: KDEData
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